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The General Mission Analysis Tool (GMAT) is an open-source space mission design, 

analysis and trajectory optimization tool. GMAT is developed by a team of NASA, private 

industry, public and private contributors. GMAT is designed to model, optimize and 

estimate spacecraft trajectories in flight regimes ranging from low Earth orbit to lunar 

applications, interplanetary trajectories and other deep space missions. GMAT has also been 

flight qualified to support operational maneuver planning for the Advanced Composition 

Explorer (ACE) mission. ACE was launched in August, 1997 and is orbiting the Sun-Earth 

L1 libration point. The primary science objective of ACE is to study the composition of both 

the solar wind and the galactic cosmic rays. Operational orbit determination, maneuver 

operations and product generation for ACE are conducted by NASA Goddard Space Flight 

Center (GSFC) Flight Dynamics Facility (FDF). This paper discusses the entire engineering 

lifecycle and major operational certification milestones that GMAT successfully completed 

to obtain operational certification for the ACE mission. Operational certification milestones 

such as gathering of the requirements for ACE operational maneuver planning, gap 

analysis, test plans and procedures development, system design, pre-shadow operations, 

training to FDF ACE maneuver planners, shadow operations, Test Readiness Review (TRR) 

and finally Operational Readiness Review (ORR) are discussed. These efforts have 

demonstrated that GMAT is flight quality software ready to support ACE mission 

operations in the FDF.  

I. Introduction 

 NASA GSFC’s Navigation and Mission Design Branch (NMDB) is responsible for providing core expertise in 

navigation, trajectory design and mission analysis support for all missions at GSFC. The branch also provides on-

orbit flight dynamics operations services through the FDF. As the operational arm of the NMDB, FDF’s operational 

services include orbit determination, acquisition and data generation for space and ground networks, tracking data 

evaluation and maneuver planning support. FDF has provided orbit maneuver services for unmanned NASA 

missions of nearly every kind of orbit including earth, lunar, libration point, and deep space. Typically the FDF 

supports flight dynamics computations for more than twenty missions. One such mission includes operational 

maneuver planning and support for the ACE mission. At present, the FDF conducts ACE mission’s maneuver 

planning and operational support using FreeFlyer. FreeFlyer is a commercial-off-the-shelf (COTS) trajectory design 

tool used for spacecraft mission analysis, design and operations.  

             

 The primary objective of this paper is to describe at a high level major operational certification milestones and 

entire engineering lifecycle that GMAT went through in order to be deemed operationally certified to support ACE 

maneuver operations in the FDF. In this work, core phases from operational certification cycle that we discuss are:  

 

 Gathering of all the ACE operational maneuver support requirements levied on GMAT.  

                                                           
1
Aerospace Engineer, Navigation and Mission Design Branch  

2
Aerospace Engineer, Navigation and Mission Design Branch  
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Table 3���������û�9���F�R�P�S�D�U�L�V�R�Q�V���E�H�W�Z�H�H�Q���)�U�H�H�)�O�\�H�U���	���*�0�$�7���Z�K�H�Q��model_reorr & define_spin_axis flags are 

turned on 

TVHF 

Files Used 

Initial State Epoch  

[UTCG] 

Att. Re-orientation 

Epoch [UTCG] 

Maneuver Epoch 

[UTCG] 

GMAT SK 

�û�9 

[cm/sec] 

�û�9 
difference 

[mm/sec] 

Vec420.txt 19 Nov 2012 00:00:00.000 19 Nov 2012 15:59:50.000 19 Nov 2012 17:30:00.000 29.65 0.021 

Vec430.txt 14 Jan 2013 00:00:00.000 15 Jan 2013 16:03:08.000 15 Jan 2013 17:30:00.000 19.97 0.015 

Vec450.txt 01 Apr 2013 00:00:00.000 02 Apr 2013 17:49:36.899 02 Apr 2013 19:15:00.000 19.47 0.018 

Vec472.txt 09 Jul 2013 00:00:00.000 09 Jul 2013 16:42:37.000 09 Jul 2013 17:40:00.000 15.30 0.012 

 

Both short and long-term propagation comparisons were also done between GMAT and FreeFlyer using 

historical navigation solutions from 4 TVHF files. Table 4 shows both short (28 days) and long-term (180 days) 

propagation comparisons between the two tools. In GMAT, short and long-term propagations were generated after 

running ACE_impulsive_NOAA28day_vec###.script. 

Table 4:   Short and long-term propagation comparisons between GMAT and FreeFlyer 

TVHF 

Files Used 

Initial State Epoch  

[UTCG] 

RSS position error after 28 

days in EarthMJ2000Eq 

[mm] 

RSS position error after 180 

days in EarthMJ2000Eq 

[meters] 

Vec433.txt 25 Jan 2013 00:00:00.000 0.50 2.72 

Vec440.txt 23 Feb 2013 00:00:00.000 2.9 3.04 

Vec450.txt 01 Apr 2013 00:00:00.000 6.1 2.62 

Vec456.txt 11 Apr 2013 00:00:00.000 1.6 4.73 

The requirement for propagation comparisons between the two tools stated that after 28 and 180 days of 

propagation, the RSS position error must be less than 10 millimeters and 5 meters respectively. Table 4 shows that 

for all TVHF files used, the RSS position error after 28 and 180 days of propagation is way less than 10 mm and 5 

meters respectively. This demonstrates that for both short (28 days) & long-term (6 months) propagations, both tools 

show an excellent agreement between each other. There is only millimeter level disagreement between the two tools 

after 28 days of propagation and a few meters level difference after 180 days long propagation.  

 This comparative analysis of station-keeping impulsive delta-v, short and long-term propagations between the 

two tools demonstrated the validity of GMAT’s ACE maneuver planning and product generation scripts. GMAT’s 

output was successfully validated against FreeFlyer’s output and the results further demonstrated that GMAT’s ACE 

operational scripts can be used to run parallel, non-interfering shadow operations for the ACE mission in the FDF. 

On 09/23/2013, the FDF’s ACE maneuver planning team used GMAT’s maneuver planning and product generation 

scripts during a “live” station-keeping maneuver. One sub-team of the maneuver team used FreeFlyer scripts to 

conduct direct station-keeping maneuver planning for the ACE mission, while another team used GMAT scripts and 

performed non-interfering, parallel shadow operations. The end results from these non-interfering shadow 

operations will be discussed later.      
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F. Development of Local Operating Procedures and Test Plans 

 

Currently within the FDF, the ACE maneuver planning team uses a Local Operating Procedures (LOP) 

document that provides step-by-step instructions to the Mission Analysts (MAs) in how to support ACE maneuver 

operations using FreeFlyer scripts. This primary governing document for supporting ACE maneuver planning effort 

using FreeFlyer is called FDSS-LOP-0136 ACE LOPs_v2. This FreeFlyer based LOP document covers various 

maneuver procedures for the ACE mission. Some key procedures include:  

 

�x Procedure for obtaining weekly ACE �' V for Future Station-keeping Maneuver 

�x Procedure for ACE Maneuver planning one week prior to the maneuver 

�x Procedure for ACE Maneuver planning one day prior to maneuver 

�x Procedure for final SK Maneuver planning (Post-Attitude Maneuver) 

�x Procedure for generating NOAA 28-day Ephemeris 

�x Procedure for delivering products via DataViewer 

 

A complete list of all procedures that are based on FreeFlyer for end-to-end ACE maneuver operational support can  

be found in the FDSS-LOP-0136 ACE LOPs_v2 document.
8 

 

Since the ACE maneuver planning team will be using GMAT scripts to perform parallel maneuver planning and 

support for the ACE mission, hence it was essential to write a LOP document that references GMAT ACE maneuver 

planning scripts. We wrote a detailed, 45 pages long LOP document called GMAT-ACE-LOP_v4. This GMAT 

based LOP document provides detailed instructions to the ACE MAs in how to successfully support ACE maneuver 

and product generation operations using only GMAT scripts. The GMAT-ACE-LOP_v4 document includes key 

ACE operational support procedures similar to the ones listed above. The GMAT-ACE-LOP_v4 document went 

through several internal reviews and test cycles that were performed both by GMAT development and ACE 

maneuver planning team members. The final version of this document was submitted to the FDF and officially 

approved by the ACE maneuver planning team. For demonstration purposes, appendix 2 shows only some sample 

procedures from GMAT-ACE-LOP_v4 document. Please reference the GMAT-ACE-LOP_v4 document for 

complete and detailed lists of all GMAT based procedures that were written to support ACE maneuver planning 

effort.
9
  

 

In order to test all 97 ACE operational support requirements that were levied on GMAT, test plans were written 

using the standard FDF processes and templates. The FDF uses a test plan and procedures document called Form 15. 

The ACE maneuver planning requirements are sub-divided into 6 requirements areas: Coordinate System, Force 

Model, Maneuver Targeting, Orbit Propagation, Product Output and Spacecraft model. The ACE Requirements 

Traceability Matrix (appendix 1) shows all 97 requirements that are sub-divided into these 6 requirements areas. We 

wrote detailed test plans documents (Form 15’s) that listed step-by-step procedures of how to test all 97 

requirements that fall within the 6 requirements areas. These test plans were delivered to the FDF’s ACE maneuver 

team. The ACE maneuver team implemented all the test plans and tested to see if GMAT meets all levied 

requirements. With the FDF, the results after implementation of test plans are tabulated in a document called Form 

16’s. The testers issued a results form 16 for each form 15 that contained detailed test plans and procedures. For 

each test plan, the testers issued either a pass or fail grade. Figure 9 shows Requirements to Test Traceability Matrix 

(RTTM). The RTTM shows GMAT’s 6 requirements areas, the test plans (Form 15’s) that were written to test the 

levied requirements and the last column shows the results and status of the test plans. As can be seen in the Status 

column, a grade of pass was issued for all the requirements that were levied on GMAT. For demonstration purposes, 

appendix 3 shows only some sample test plans (Form 15’s) that were written to test the levied requirements. A 

complete list of all Form 15’s that we wrote and delivered to the ACE maneuver team can be found in GMAT-ACE-

Test-Plans-Form15s.zip test plans zip file.
10
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Pre-Shadow Operations Completed Wrote GMAT ACE scripts. A vigorous analysis involving 

comparison between GMAT & FreeFlyer’s propagation and 

maneuver targeting results was conducted.  

Local Operating Procedures 

& Test Plans Development 

Completed  �x Wrote detailed test procedures document (ACE Local 

Operating Procedures (LOP)) that provides instructions 

to FDF’s Mission Analysts for supporting ACE 

maneuver operations. 

�x Wrote detailed Test Plans documents (Form 15s) that 

covered all requirements for ACE operational maneuver 

planning. Test Plans were documented using standard 

FDF processes and templates.  

Test Procedures & Plans 

Review 

Completed FDF’s ACE maneuver team reviewed and approved test 

procedures and test plans documents 

Test Readiness Review Completed On 09/10/13, we gathered test readiness material and presented a 

successful TRR to FDF’s FRB 

FDF Training Completed Provided training to ACE maneuver planning team which 

involved instructions on how to use GMAT’s ACE impulsive 

maneuver targeting and product generation scripts. 

Shadow Operations Completed On 09/23/2013, FDF’s ACE maneuver planning team used GMAT 

in parallel shadow operations. ACE maneuver team performed 

maneuver targeting using GMAT and compared solutions to 

FreeFlyer. Delivery products from GMAT were used in 

downstream work flows alongside products from FreeFlyer to 

provide end-to-end verification of GMAT solutions and product 

formats.  I was available for technical support during shadow 

operations but work was performed by ACE maneuver team.   

Operational Readiness 

Review 

Completed On 11/19/2013, we presented ORR to the FRB and presented 

findings of shadow operations and results after test plans were 

implemented by the ACE maneuver team. GMAT successfully 

passed ORR and FRB  has granted GMAT full operational 

certification status to support ACE mission operations in the FDF 

  

The primary focus of this effort was to demonstrate that GMAT is a mature, flight quality system that has been 

operationally certified to support real-time spacecraft mission operations. The work that we presented here is unique 

because prior to this effort, GMAT had never gone through an operational certification cycle in order to be deemed 

qualified to support mission operations in the FDF. Now in addition to being certified for ACE operations, this work 

has laid core groundwork for GMAT to target operational certification for other present and future Goddard 

missions. GMAT is installed in FDF’s mission operations room and now in addition to FreeFlyer, GMAT can be 

used as the primary maneuver planning tool to support ACE mission operations. 
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FM01 Force Model Geopotential Model - Zonal Terms The ground system must utilize a geopotential model with a minimum of eight (8) zonal terms.

FM02 Force Model Geopotential Model - Tesseral Terms The ground system must utilize a geopotential model with a minimum of eight (8) tesseral terms.

FM03 Force Model Gravitational Point Masses - Sun The ground system must model the Sun as a point mass.

FM04 Force Model Gravitational Point Masses - Moon The ground system must model the Moon (Luna) as a point mass.

FM05 Force Model Gravitational Point Masses - Mercury The ground system must model Mercury as a point mass.

FM06 Force Model Gravitational Point Masses - Venus The ground system must model Venus as a point mass.

FM07 Force Model Gravitational Point Masses - Mars The ground system must model Mars as a point mass.

FM08 Force Model Gravitational Point Masses - Jupiter The ground system must model Jupiter as a point mass.

FM09 Force Model Gravitational Point Masses - Saturn The ground system must model Saturn as a point mass.

FM10 Force Model Gravitational Point Masses - Uranus The ground system must model Uranus as a point mass.

FM11 Force Model Gravitational Point Masses - Neptune The ground system must model Neptune as a point mass.

FM12 Force Model Gravitational Point Masses - Disable The ground system shall support enabling and disabling any solar system point masses prior to script execution.

FM13 Force Model SRP - Modeling The ground system must allow the user to set the mean solar flux.

FM14 Force Model C sub R - User Defined The ground system must allow the user to modify C sub r, the solar radiation parameter, prior to runtime.

FM15 Force Model Planetary Ephemeris The ground system must support the use of DE421 and DE405 planetary ephemeris files.

HF01 Human Factors Internet Connectivity
The ground system shall not lose functionality when used on a computer without internet connectivity (There is no expectation of 
ground system functionality if FDFNet, or any relevant software server license, is down or otherwise non-functional).

HF02 Human Factors Operating System - Win7 The ground system shall operate on Windows 7.
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Appendix 3:   Test Plans (Form 15’s) that cover Product Output (PO) requirements Area  
 

Module/Software:  ACE Impulsive Maneuver Planning 

Version:  

Mission (or N/A): Task 9,  ACE Maneuver  

Date:  09/04/13 

Testers:   

 

TEST DESCRIPTION 

Demonstrate NOAA ephem output, code 500 ephems, visualizations and maneuver summary report: 

Demonstrate that GMAT can output NOAA ephem, Code 500 ephems and maneuver summary report after each run. 

 

REFERENCE DOCUMENT DOCUMENT LOCATION 

  

 

SYSTEM CONFIGURATION 

THIS SHOULD BE A BRIEF DESCRIPTION OF THE TEST SETUP ENVIRONMENT (SYSTEM NAME OR 

OTHER INFORMATION THAT CAN BE USED TO IDENTIFY HARDWARE, NETWORK, SOFTWARE, 

SERVERS AND OTHER SYSTEM CONFIGURATION INFORMATION) REQUIRED FOR VALID TEST 

EXECUTION 

 Workstation with access to FDFNet and GMAT R2013b, using ACE_impulsive_NOAA28day_vec450.script & 

ACE_impulsive_Burn_XXX.script             

 

FUNCTIONALITIES TESTED/REQUIRMENTS  

This test plan is testing following requirements from ACE requirements document (FDSS-TO9 Maneuver Task 

Requirements Traceability Matrix - ACE only.xlsx) : 

 

PO01: The ground system shall generate a NOAA Ephemeris, as delineated in Appendix A. 

 

PO 02: The ground system shall support generating ephemeris files starting with a user-defined epoch, which may 

differ from the maneuver epoch. 

 

PO 03: The ground system shall be able to generate an ephemeris in the Unix version of the GSFC Code 500 binary 

format. 

 

PO 04: The ground system shall be able to generate an ephemeris in the PC version of the GSFC Code 500 binary 

format. 

 

PO 05: The ground system must be able to display a visualization of the spacecraft's orbit during propagation in the 
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3. Open GMAT and load script ACE_impulsive_Burn_XXX.script. Within the Resources tree, this script will 

�V�K�R�Z���X�Q�G�H�U���6�F�U�L�S�W�V���I�R�O�G�H�U�����2�S�H�Q���W�K�L�V���V�F�U�L�S�W���D�Q�G���F�O�L�F�N���³�6�D�Y�H���6�\�Q�F���´���7�K�L�V���S�R�S�X�O�D�W�H�V���*�0�$�7�¶�V���5�H�V�R�X�U�F�H�V���D�Q�G��

Mission tree. 

 

4. �*�R���W�R���0�L�V�V�L�R�Q���W�U�H�H���D�Q�G���R�S�H�Q���³�8�V�H�U���,�Q�S�X�W�V�´���6�F�U�L�S�W�(�Y�H�Q�W�����8�Q�G�H�U��Input state section, notice use_tvhf is set to 

1 by default. This means GMAT �Z�L�O�O���U�H�D�G���V�S�D�F�H�F�U�D�I�W�¶�V���L�Q�L�W�L�D�O���H�S�R�F�K�����V�W�D�W�H���	���&�U���I�U�R�P���Y�H�F���������W�[�W�����$�O�O���R�I���W�K�H��

correct epochs and other parameters that correspond to vec450.txt vector file have already been entered into 

variables that are listed under Attitude Reorientation, Maneuver & Post maneuver epoch sections.  

 

Notice that model_reorr flag is turned on, attitude reorientation epoch has already been entered into 

reorr_epoch, radial, tangential, normal components have already been entered into reorr_radial, 

reorr_tangential, reorr_normal. Also appropriate fuel has also been entered into reorr_fuel_used.   

 

Correct maneuver epoch has been entered for maneuver_epoch, target_crossing is set to 4, correct tank 

mass is entered for tank_mass, appropriate fuel used has already been added for sk_fuel_used. Notice that 

define_spin_axis flag is turned on and appropriate RA and DEC values have already been added to Z_RA 

and Z_Dec.   

 

Under Post maneuver epoch section, postmaneuver_epoch is where user enters a user-defined epoch, which 

differs from the maneuver epoch. After targeter converges, spacecraft propagates to user-defined post 

maneuver epoch and ephemeris files are generated starting from the user-defined epoch defined in 

postmaneuver_epoch. This satisfies requirement listed under PO02 REQ-ID. Code 500 ephemeris (both PC 

�D�Q�G���8�1�,�;���Y�H�U�V�L�R�Q�V�����D�Q�G���P�R�G�L�I�L�H�G���U�H�S�R�U�W���I�L�O�H���³�*�0�$�7�H�S�K�H�P�´���D�U�H���J�H�Q�H�U�D�W�H�G���V�W�D�U�W�L�Q�J���I�U�R�P���W�K�H���S�R�V�W��

maneuver epoch that the user defines in postmaneuver_epoch. A correct post maneuver epoch (which 

corresponds to vec450.txt vector fi�O�H�����K�D�V���D�O�U�H�D�G�\���E�H�H�Q���G�H�I�L�Q�H�G���I�R�U���W�H�V�W�H�U�¶�V���F�R�Q�Y�H�Q�L�H�Q�F�H���� 

 

NumDays_after_maneuver is where user defines the total # of days for which code 500 ephemeris and 

�³�*�0�$�7�H�S�K�H�P�´���U�H�S�R�U�W���I�L�O�H�V���Z�L�O�O���E�H���J�H�Q�H�U�D�W�H�G���I�R�U�����%�\���G�H�I�D�X�O�W����NumDays_after_maneuver is set to 180 days, 

�Z�K�L�F�K���U�R�X�J�K�O�\���H�T�X�D�O�V���W�R���$�&�(�¶�V���I�X�O�O���R�U�E�L�W���U�H�Y�R�O�X�W�L�R�Q�����7�K�L�V���Y�D�U�L�D�E�O�H���F�D�Q���E�H���P�R�G�L�I�L�H�G���D�W���X�V�H�U�¶�V���F�K�R�L�F�H�� 

 

5. �6�L�Q�F�H���³�8�V�H�U���,�Q�S�X�W�V�´���6�F�U�L�S�W�(�Y�H�Q�W���L�V���D�O�U�H�D�G�\���F�R�Q�I�L�J�X�U�H�G���Z�L�W�K���D�S�S�U�R�S�U�L�D�W�H���S�D�U�D�P�H�W�H�U�V�����Z�H���D�U�H���U�H�D�G�\���W�R���U�X�Q��

�*�0�$�7�����&�O�L�F�N���2�.���W�R���F�O�R�V�H���³�8�V�H�U���,�Q�S�X�W�V�´���6�F�U�L�S�W�(�Y�H�Q�W & click on Run button (located below and slightly to 

the right of Help tab). 

 

As GMAT is running, user will see two graphics windows and two XY Plot windows. 

�³�(�D�U�W�K�6�X�Q�0�R�R�Q�9�L�H�Z�´���J�U�D�S�K�L�F�V���Z�L�Q�G�R�Z���V�K�R�Z�V���V�S�D�F�H�F�U�D�I�W���L�Q���5�/�3���F�R�R�U�G�L�Q�D�W�H���I�U�D�P�H�����³�(�D�U�W�K�6�X�Q�9�L�H�Z�´��

graphics window shows ACE in earth-sun-rotating coordinate system & XY plot on bottom right shows 

ACE in XY RLP frame as the targeter runs and converges for up to 4 RLP XZ plane crossings. XY plot on 

bottom left shows spacecraft in XY RLP frame propagating forward starting from post maneuver epoch 
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FM01 Force Model Geopotential Model - Zonal Terms The ground system must utilize a geopotential model with a minimum of eight (8) zonal terms.

FM02 Force Model Geopotential Model - Tesseral Terms The ground system must utilize a geopotential model with a minimum of eight (8) tesseral terms.

FM03 Force Model Gravitational Point Masses - Sun The ground system must model the Sun as a point mass.

FM04 Force Model Gravitational Point Masses - Moon The ground system must model the Moon (Luna) as a point mass.

FM05 Force Model Gravitational Point Masses - Mercury The ground system must model Mercury as a point mass.

FM06 Force Model Gravitational Point Masses - Venus The ground system must model Venus as a point mass.

FM07 Force Model Gravitational Point Masses - Mars The ground system must model Mars as a point mass.

FM08 Force Model Gravitational Point Masses - Jupiter The ground system must model Jupiter as a point mass.

FM09 Force Model Gravitational Point Masses - Saturn The ground system must model Saturn as a point mass.

FM10 Force Model Gravitational Point Masses - Uranus The ground system must model Uranus as a point mass.

FM11 Force Model Gravitational Point Masses - Neptune The ground system must model Neptune as a point mass.

FM12 Force Model Gravitational Point Masses - Disable The ground system shall support enabling and disabling any solar system point masses prior to script execution.

FM13 Force Model SRP - Modeling The ground system must allow the user to set the mean solar flux.

FM14 Force Model C sub R - User Defined The ground system must allow the user to modify C sub r, the solar radiation parameter, prior to runtime.

FM15 Force Model Planetary Ephemeris The ground system must support the use of DE421 and DE405 planetary ephemeris files.

HF01 Human Factors Internet Connectivity
The ground system shall not lose functionality when used on a computer without internet connectivity (There is no expectation of 
ground system functionality if FDFNet, or any relevant software server license, is down or otherwise non-functional).

HF02 Human Factors Operating System - Win7 The ground system shall operate on Windows 7.
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MT01 Maneuver Targeting Automatic TCOPS Ingest The ground system must be capable of ingesting TCOPS Vector Hold Files without user input.

MT02 Maneuver Targeting Manual TCOPS Ingest The ground system must be capable of inputting TCOPS Vector Hold File parameters manually.

MT03 Maneuver Targeting Manual Ingest - State Epoch The ground system must allow the user to manually input an initial spacecraft state epoch.

MT04 Maneuver Targeting Manual Ingest - State Vector The ground system must allow the user to manually input an initial spacecraft state vector.

MT05 Maneuver Targeting Automatic TCOPS Ingest - State VectorThe ground system must be capable of ingesting the state vector from the TCOPS Vector Hold Files  without user input.

MT06 Maneuver Targeting Automatic TCOPS Ingest - Epoch The ground system must be capable of ingesting the epoch from the TCOPS Vector Hold Files  without user input.

MT07 Maneuver Targeting Automatic TCOPS Ingest - Cr The ground system must be capable of ingesting C_r from the TCOPS Vector Hold Files without user input.

MT08 Maneuver Targeting Impulsive Maneuver Targeting The ground system must be capable of impulsive maneuver targeting.

MT09 Maneuver Targeting Differential Corrector The ground system shall have a differential corrector.

MT10 Maneuver Targeting Impulsive Targeting - Maneuver EpochThe ground system shall use a user-input maneuver epoch for impulsive targeting.

MT11 Maneuver Targeting delta-V - Body Z
The ground system shall support varying the delta-V along the spacecraft body Z-axis during differential correction of impulsive 
maneuver targeting.

MT12 Maneuver Targeting
Differential Correction - X-Z Plane 
Crossings

The ground system shall propagate the spacecraft to a user-specified number of X-Z plane crossings in the Rotating Libration Point 
(RLP) frame during differential correction of impulsive maneuver targeting.

MT13 Maneuver Targeting Differential Corrector - Accuracy
The differential corrector shall compute a delta-V vector which achieves an accuracy better than 0.00000 – 0.000001 km/s along X 
component of the velocity in the RLP frame (e.g., the Earth-Sun line) on the fourth X-Z plane crossing.

MT14 Maneuver Targeting RLP X-Z Plane Crossings
The ground system shall have the ability to use as input the number of X-Z plane crossings in the Rotating Libration Point (RLP) 
frame through which to propagate in an impulsive targeting loop.

MT15 Maneuver Targeting Targeting Loop - Iteration When in a targeting loop, the ground system shall display the current targeting iteration.

MT16 Maneuver Targeting Maneuver Coordinate System - ACE The ground system shall be able to target a maneuver in the ACE coordinate system.

MT17 Maneuver Targeting Maneuver Coordinate System - RLP The ground system shall be able to target a maneuver in the RLP coordinate system.

MT18 Maneuver Targeting Maneuver Coordinate System - LVLH The ground system shall be able to target a maneuver in the LVLH coordinate system.

MT19 Maneuver Targeting Maneuver Coordinate System - J2000The ground system shall be able to target a maneuver in the J2000 coordinate system.
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OP01 Orbit Propagation Propagation Accuracy The ground system propagator shall maintain eighth-order numerical accuracy  (e.g., RK8(9))

OP02 Orbit Propagation Long-Term Propagation The ground system shall support propagation up to 10 years from the start epoch.

OP03 Orbit Propagation Time Accuracy The ground system shall support millisecond time precision for all functions and parameters.

OP04 Orbit Propagation Mass Accuracy The ground system shall support gram (0.001 kilogram)  mass precision for all functions and parameters .

OP05 Orbit Propagation Ten year orbit maintenance
The ground system shall be able to predict maneuvers (with a frequency of once every two years, plus or minus six months) to 
maintain a Lissajous orbit for at least 10 years.

OP06 Orbit Propagation No-burn ephemeris The ground system shall be able to generate a no-burn predictive ephemeris of a user-specified duration up to 14 days.

PO01 Product Output NOAA Ephemeris The ground system shall generate a NOAA Ephemeris, as delineated in Appendix A.

PO02 Product Output Output Epoch Length
The ground system shall support generating ephemeris files starting with a user-defined epoch, which may differ from the 
maneuver epoch.

PO03 Product Output GSFC Code 500 Ephemeris - Unix The ground system shall be able to generate an ephemeris in the Unix version of the GSFC Code 500 binary format.

PO04 Product Output GSFC Code 500 Ephemeris - PC The ground system shall be able to generate an ephemeris in the PC version of the GSFC Code 500 binary format.

PO05 Product Output XY RLP Frame Visualization The ground system must be able to display a visualization of the spacecraft’s orbit during propagation in the XY RLP frame.

PO06 Product Output Real Time Updates
The ground system must be able to display visualizations during propagation (i.e., the ground system must not wait until runtime 
completion to display outputs).

PO07 Product Output Maneuver Summary Report The ground system shall generate a maneuver summary report as delineated in Appendix B.

SP01
Spacecraft 
Parameters Dry Mass - User Input The ground system must allow the user to input the dry mass of the spacecraft prior to runtime.

SP02
Spacecraft 
Parameters Drag Area - User Input The ground system must allow the user to input the drag area of the spacecraft prior to runtime.

SP03
Spacecraft 
Parameters Pre-burn Fuel Mass The ground system must model the pre-burn spacecraft fuel mass.

SP04
Spacecraft 
Parameters Post-burn Fuel Mass The ground system must model the post-burn spacecraft fuel mass.

SP05
Spacecraft 
Parameters Attitude Adjust Delta-V

When provided with an epoch and a delta-V vector in the Local Vertical Local Horizontal (LVLH) frame, the ground system shall be 
capable of modeling the orbit perturbation due to the attitude maneuver.

SP06
Spacecraft 
Parameters Attitude Adjust Fuel Usage The ground system shall support decrementing a spacecraft’s fuel mass when provided with a fuel usage.

SP07
Spacecraft 
Parameters Spacecraft SRP Area The ground system must define the SRP area of a spacecraft.

SP08
Spacecraft 
Parameters SRP Area - User Input The ground system must allow the user to input the SRP area of the spacecraft.
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Appendix 2:   Sample Procedures copied from GMAT-ACE-LOP_v4 document 

5.3 ACE Maneuver Planning 

The information below details ACE maneuver planning including preliminary and final planning, maneuver 

execution, and post-maneuver activities.  More detailed procedures are referenced where necessary, refer to them as 

needed. 

5.3.1 One Week Prior to Maneuver 

1. Retarget V using the weekly ACE V procedure in section 5.1 if necessary. 

2. Once the SK maneuver date is selected, inform Operations Analysts (OAs) within FDF so information can be 

added to FDF Activity Schedule. 

3. Send brief on SK maneuver to FOT and Orbit personnel. 

a. GSFC-DL-MMOC-FOT@mail.nasa.gov, robert.j.sodano@nasa.gov, rivers.lamb@nasa.gov, 

edward.m.nace@nasa.gov,  

gsfc-fdf-maneuver@lists.nasa.gov 

5.3.2 One Day Prior to Maneuver 

1. Check for a new OD state file (vec###), move to the appropriate folder. 

2. Copy and rename the previous ACE_impulsive_###.script into a new vector folder.  

3. Create a new SK-## folder with the current Station-keeping maneuver number. 

4. An email with a GMAN .lst file will be sent with pre-attitude maneuver information.  

5. Under Resources tree, look for Interfaces folder and open resource called “tvhf”. 

a. Under Filename field, search for the appropriate OD vector file …\vec###.txt file by clicking on the 

Browse button and click OK 

6. Edit all instances of vec### & SK## to the current vector number from OD and to the current station keeping 

number. If needed, refer to procedure in section 5.1 that explains how to edit GMAT’s Resource objects (listed 

under Output folder) with updated vec### & SK## in Resources tree. After updating all subscribers listed 

under the Output folder, don’t forget to click on Save button. This ensures that changes you made are saved 

and GUI and Script modes are synchronized.    

7. Click on the Mission tab and open the “User Inputs” ScriptEvent. Implement the following steps: 

a. Make sure that use_tvhf is set to 1 

b. Make sure that no_burn_prop is set to 0 

c. For preliminary maneuver targeting, the model_reorr variable should be set to 1 (turned on) 

d. Update reorr_epoch, reorr_radial, reorr_tangential, reorr_normal, and reorr_fuel_used with values from 

the .lst file 

e. Double check that the maneuver_epoch is set to the correct data and time 

f. maneuver_seed can be initially set to 0, or if retargeting from a previous week, left as is 

g. target_crossing can be set to 4.  GMAT’s script should converge just fine if set to 4 

h. tank_mass should be set to the value found in the .lst file 

i. sk_fuel_used: Most recent value should be entered here 



23 

American Institute of Aeronautics and Astronautics 

 

 

j. define_spin_axis should be set 1 (turned on) 

k. Z_RA and Z_Dec should be updated from same .lst file 

l. postmaneuver_epoch should be set to nearest even hour after the epoch that is defined under 

maneuver_epoch 

m. NumDays_after_maneuver is by default set to 180 days. User can set it to any desired value 

8. You can also consult Table 3 in Appendix B in order to get a summary of input variables or flags that need to 

be turned on/off in order to successfully run section 5.3.2 of this LOP. 

9. Click OK to close “User Inputs” ScriptEvent. Click on Save button (located below the Edit tab). Clicking on 

Save button ensures that your changes are saved and it also makes certain that GMAT’s GUI and Script modes 

are both synchronized.  

10. Click on Run button and GMAT’s targeter should converge. After mission run has completed, you can access 

appropriate report and ephemeris files to obtain any pertinent data. For example, “skSummaryReport” in 

Output tree contains data like ACE’s state at SK start, impulsive SK delta-v components or post burn state.  

11. Now access ΔV vector components from GMAT and convert to ft/s. (ΔV vector components can be found in 

“skSummaryReport” report file under “Impulsive SK Delta-v Components” section of the report). 

12. Using the procedure “Generating ACE Maneuver plan in GMAN” defined in section 5.4, create a preliminary 

maneuver plan. Details on required inputs are below. 

a. New ephemeris based on latest OD (span must include maneuver epoch). This can be generated using 

the same ACE_impulsive_###.script. Open “User Inputs” ScriptEvent, set no_burn_prop to 1 (setting 

this flag to 1 makes sure that ACE_impulsive_###.script will now only generate two week long no 

burn propagation). NumDays by default is set to 14 (two weeks). Click OK to close “User Inputs” 

ScriptEvent. Click on Save button in order to ensure that GMAT’s GUI and Script modes are 

synchronized and changes that were made are saved. Now run GMAT by hitting the Run button to 

simulate the two weeks long no burn propagation. 

b. After run, GMAT’s two weeks long no-burn propagation report file (“ephem_GMAT_nb”) can be 

viewed in Output tree or this file can be found in the path where this modified report was saved into. 

Also code 500 (PC version) ephemeris file for two weeks long no-burn propagation that was generated 

using the “ephem_code500_pc_nb” EphemerisFile object  can be found in the path where it was saved 

into. 

c. The axial thrusters used for the burn depend on the direction of the delta-v. 1A and 2A are for anti-

Sunward, 3A and 4A for sunward. 

d. Fuel tank weights (lbm), pressures (psi), and temperatures (C) are from the last post-maneuver sk-

##p_calib-01.lst file.  

e. Spin rate (rpm) and spin axis RA / DEC (deg) are from the pre-attitude .lst file 

f. DSN Ground Tracking Station that will be used during the maneuver. See section 5.8.2 for details on 

determining the DSN station. 

g. Thrust and Isp Calibration factors which are determined from previous maneuver calibration that used 

the same set of thrusters, same/similar delta-v, or based on analysis. Isp Calibration is nominally the 

same as the thrust calibration factors. 

13. Run and QA GMAN output based on the procedure in section 5.4 
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5.3.3 Final Orbit SK Maneuver Planning (Post-Attitude Maneuver) 

1. Use the ACE_impulsive_###.script to generate the final maneuver plan (Refer to procedure in section 5.1 if 

needed). 

a. Place latest attitude reorientation ΔV (RTN) values received from the FOT into the Attitude Reorientation 

section of the “User Inputs” ScriptEvent. This will be given via a phone call. 

b. Input the updated tank_mass into the Maneuver section of “User Inputs” ScriptEvent.  

c. Calculate and input the midpoint of the reorientation burn epoch in reorr_epoch into Attitude Reorientation 

section of the “User Inputs” ScriptEvent.   

d. Input actual spin axis RA/DEC (from FOT) into Z_RA and Z_Dec into Maneuver section of “User Inputs” 

ScriptEvent.  

e. Click OK to close “User Inputs” ScriptEvent and click on Save button. Now run GMAT by clicking on Run 

button. Targeter should converge after few iterations. 

f. Now obtain new ΔV for SK burn by opening “skSummaryReport” report file in Output tree. This report file 

can also be accessed from the path that the user selected to save this report file into. 

2. Open the final GMAN .lst file sk-##p_final-01.lst (refer to section 5.4 if needed). 

a. Place new ΔV magnitude (converted from km/sec to ft/sec) into GMAN namelist.  

b. Input latest post-reorientation spin axis RA/DEC/SPIN updates (from FOT) 

c. Input latest fuel tank PRESSURES/TEMPS/FUEL WEIGHTS plus JET (thruster) TEMPS (all values from 

FOT). 

d. Run GMAN via the command prompt and inspect/QA .lst file and command sheet file. 

3. Transmit Command Sheet file to FOT via the DataViewer SendRequest function (see Section 5.8).  File placed 

on stewart in directory ACE/MOC/Maneuver as: ACE_SkCommand_yyyymmdd.nn.cmd 

4. Check that DSN 2-way tracking data is arriving including Doppler (see Section 5.8.2) 

5. Calculate predicted drop in spin rate by taking the previous maneuver’s drop (() (i.e., maneuver that used 

the same thrusters) and multiplying it by the ratio of the current burn duration, T, to the previous maneuver’s 

T to get the estimated drop for the current maneuver.  The equation for this is: 

 

Drop in spin rate = previous man.  * (current man. T / previous man. T) 

 

6. Call FOT at 6-4712 or 6-4927 and let them know the expected drop in the spin rate due to the Station-keeping 

maneuver. 
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5.6 Generating NOAA 28-day Ephemeris 

The purpose of this part of these Local Operating Procedures (LOP) is to generate a NOAA 28-day ephemeris using 

GMAT. 

Table 4 in Appendix B lists general description of all input variables and their usage. These input variables are set in 

the “User Inputs” ScriptEvent found in GMAT’s ACE_impulsive_NOAA28day_vec###.script. After loading the 

script in GMAT, within the Mission tree, the user needs to only amend the input variables found in “User Inputs” 

ScriptEvent and no other ScriptEvents should require any modifications. 

Table 5 in Appendix B lists how the input variables in “User Inputs” ScriptEvent should be set up in order to 

successfully run section 5.6.1 of this LOP.  

5.6.1 Procedure 

This procedure should be performed on a cycle of approximately once every 14 days and immediately after every 

station-keeping maneuver. 

1. An email with the latest vector should have been received from Orbit Group.  Note the     vector number, 

retrieve from the Unix side directory missions/ace/products/tvhf and place on Windows-side 

directory in R:\FDDFDOA\PROJECTS\ACE\MNVR\EPHEMS\TVHF. It should have the naming 

convention of vec###.txt, where ### is the vector number.  

2. Find the previous ACE_impulsive_NOAA28day_vec###.script. Copy and rename to the current vector 

number. Open the script in GMAT and click on “Save,Sync” button to populate GMAT’s Resources and 

Mission trees.  

3. Under the Resources tree, look for Interfaces folder and open resource called “tvhf”. 

a. Under Filename field, search for the appropriate OD vector file …\vec###.txt file and click OK to 

close the FileInterface - tvhf resource. 

4. Under Resources tree, look for Output folder and open “skSummaryReport” ReportFile object. 

“skSummaryReport” is a modified report file which contains various data fields like spacecraft’s state at SK 

start, impulsive SK Delta-V components. 

a. Under Filename field, browse for the appropriate path where you would like to save this report file. 

Name this report file with the name of your choice (default name is 

…\SK_impulsive_GMAT_More.report). Note: After GMAT is run, the report file can be opened from 

the GMAT Output tree, or by opening the file from the file system at the path specified. Click OK to 

close this resource. 

5. Under Resources tree, look for Output folder and open “noaaReport” ReportFile object. “noaaReport” is a 

modified ephemeris report file which reports ACE’s epoch in UTCModJulian, state vector and acceleration 

vector components at intervals of every 3600 seconds for the span of 28 days. This modified ephemeris is 

delivered to NOAA and starts from epoch defined in product_start variable (product_start variable is defined 

by the user in “User Inputs” ScriptEvent located in Mission tree).  

a. Under Filename field, select the appropriate path where you would like to save this modified 

ephemeris report file. Naming convention of this ephemeris file 

is…\ACE_EPHPred_YYYYMMDD.asc, where YYYY corresponds to the 4-digit year, MM 

corresponds to the 2-digit month, DD corresponds to the 2-digit day of month. Click OK to close this 

panel. Note: After GMAT is run, the report file can be opened from the GMAT Output tree, or by 

opening the file from the file system at the path specified. 
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b. Since we have modified the GUI, we should save these changes. Click on Save button (located below 

the Edit tab). Clicking on Save button ensures that your changes are saved and also makes certain that 

GMAT’s GUI and Script modes are both synchronized. 

6. Now go to Mission tree and open  the “User Inputs” ScriptEvent and update the following variables: 

i.use_tvhf should be set to 1 

ii.product_start should be set to today’s date 

iii.Update tank_mass to current value from the attitude reorientation email 

iv.If there is no maneuver within the next 28 days, include_maneuver should be set to 0, otherwise set to 1 

and update the maneuver_epoch to the chosen date 

v.If include_maneuver is set to 1, then enter modeled dV in maneuver_seed 

vi.define_spin_axis should be set to 0 or 1 

vii.If define_spin_axis is set to 1, then enter RA and Dec for Z_RA and Z_Dec 

viii.You can also consult Table 5 in Appendix B in order to get a summary of input variables or flags that need 

to be turned on/off in order to successfully run section 5.6.1 of this LOP. 

ix.Click OK to close the “User Inputs” ScriptEvent. Click on Save button to save the changes that have been 

made. This also ensures that GUI and Script modes are synchronized.  

7. Run this script by clicking on the Run button. When run is complete, “sksummaryReport” and “noaaReport” 

can be viewed in Output tree or you can open these reports from the path where these reports were saved in. 
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Appendix 3:   Test Plans (Form 15’s) that cover Product Output (PO) requirements Area  
 

Module/Software:  ACE Impulsive Maneuver Planning 

Version:  

Mission (or N/A): Task 9,  ACE Maneuver  

Date:  09/04/13 

Testers:   

 

TEST DESCRIPTION 

Demonstrate NOAA ephem output, code 500 ephems, visualizations and maneuver summary report: 

Demonstrate that GMAT can output NOAA ephem, Code 500 ephems and maneuver summary report after each run. 

 

REFERENCE DOCUMENT DOCUMENT LOCATION 

  

 

SYSTEM CONFIGURATION 

THIS SHOULD BE A BRIEF DESCRIPTION OF THE TEST SETUP ENVIRONMENT (SYSTEM NAME OR 

OTHER INFORMATION THAT CAN BE USED TO IDENTIFY HARDWARE, NETWORK, SOFTWARE, 

SERVERS AND OTHER SYSTEM CONFIGURATION INFORMATION) REQUIRED FOR VALID TEST 

EXECUTION 

 Workstation with access to FDFNet and GMAT R2013b, using ACE_impulsive_NOAA28day_vec450.script & 

ACE_impulsive_Burn_XXX.script             

 

FUNCTIONALITIES TESTED/REQUIRMENTS  

This test plan is testing following requirements from ACE requirements document (FDSS-TO9 Maneuver Task 

Requirements Traceability Matrix - ACE only.xlsx) : 

 

PO01: The ground system shall generate a NOAA Ephemeris, as delineated in Appendix A. 

 

PO 02: The ground system shall support generating ephemeris files starting with a user-defined epoch, which may 

differ from the maneuver epoch. 

 

PO 03: The ground system shall be able to generate an ephemeris in the Unix version of the GSFC Code 500 binary 

format. 

 

PO 04: The ground system shall be able to generate an ephemeris in the PC version of the GSFC Code 500 binary 

format. 

 

PO 05: The ground system must be able to display a visualization of the spacecraft's orbit during propagation in the 
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XY RLP frame. 

 

PO 06: The ground system must be able to display visualizations during propagation (i.e., the ground system must 

not wait until runtime completion to display outputs). 

 

PO 07: The ground system shall generate a maneuver summary report as delineated in Appendix B. 

 

 

INPUT FILE DESCRIPTION INPUT FILE 

TVHF file is needed to successfully load GMAT script 

without any errors. 

Vec450.txt 

 

PARAMETER FILE PARAMETER VALUE 

   

 

Test 1:  Test PO01 requirement. Demonstrate that GMAT can generate NOAA ephemeris: 

PROCEDURE 

 

1. Make sure GMAT is closed. Before starting GMAT, make sure that GMAT’s “tai-utc.dat” leap second file 

is configured to use 34 leap seconds. Once the tester has confirmed this, then go to step 2. 

 

2. Place vec450.txt TVHF file in the bin folder (bin folder is located in GMAT’s directory). In GMAT, 

Default location for TVHF files is the bin folder. 

 

3. Open GMAT and load script ACE_impulsive_NOAA28day_vec450.script. Within the Resources tree, this 

script will show under Scripts folder. Open this script and click “Save/Sync.” This populates GMAT’s 

Resources and Mission tree. 

 

4. Go to Mission tree and open “User Inputs” ScriptEvent. Under Input state section, notice use_tvhf is set to 

1 by default. This means GMAT will read spacecraft’s initial epoch, state& Cr from vec450.txt. All of the 

correct epochs and other parameters that correspond to vec450.txt vector file have already been entered into 

variables that are listed under Product Start, Fuel Remaining & Maneuver sections. Correct product start 

epoch has been already entered. Under Maneuver section, notice that include_maneuver and 

define_spin_axis flags are turned on and correct maneuver epoch has already been entered.  

 

These input parameters will help us generate a 28 days long NOAA ephemeris which is based off of 

vec450.txt. Since “User Inputs” ScriptEvent is already configured with appropriate parameters, we are 

ready to run GMAT. Click OK to close “User Inputs” ScriptEvent & click on Run button (located below 

and slightly to the right of Help tab). 
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As GMAT is running, note two graphics windows and single XY Plot window. EarthSunMoonView 

graphics window shows ACE in RLP coordinate frame, EarthSunView graphics window shows ACE in 

earth-sun-rotating coordinate system, XY plot on bottom center shows ACE in XY RLP frame. 

 

5. After run, go to Output tree and open “noaaReport” report file. This is the report file that generates 28 days 

long NOAA ephemeris as delineated by requirements listed in Appendix A. This 28 days long NOAA 

report reports Mod. Julian date, state vector, acceleration components at 1-hour time steps. 

 

This “noaaReport” was generated after creating and configuring noaaReport ReportFile object in lines 408 

through 420 of the script. This “noaaReport” object can also be seen in Resources tree under the Output 

folder. Now go to Output folder (located in GMAT’s directory). In GMAT, Output folder is where all the 

reports and ephemeris files are saved by default. Notice that a NOAA file by the name of 

"ACE_EPHPred_20130402.asc" is created. 

 

You can either open “noaaReport” in GMAT’s Output tree or open "ACE_EPHPred_20130402.asc" in 

Notepad++ or any other text editor to study it in detail. Study the contents of this NOAA ephemeris and 

tester can validate it against FreeFlyer’s 28 days long NOAA ephemeris. GMAT’s 

"ACE_EPHPred_20130402.asc" meets PO01 requirement as well as all of the requirements delineated in 

Appendix A (i.e. NE1 through NE10 requirements).     

                                                                     

6. The user can completely close GMAT by going to File>Exit.  

 

 

EXPECTED RESULTS 

GMAT will demonstrate successful creation of 28 days long NOAA ephemeris, hence satisfying PO01 and NE01 

through NE11 REQ-IDs.   

ACCEPTANCE CRITERIA 

Validate expected results by running FreeFlyer with same input parameters used in “User Inputs” ScriptEvent.  

 

Test 2:  Test PO02 through PO07 requirements. Demonstrate code 500 ephem generation, visualization and 

maneuver summary report: 

PROCEDURE 

 

1. Make sure GMAT is closed. Before starting GMAT, make sure that GMAT’s “tai-utc.dat” leap second file 

is configured to use 34 leap seconds. Once the tester has confirmed this, then go to step 2.  

 

2. Make sure vec450.txt TVHF file in the bin folder (bin folder is located in GMAT’s directory). In GMAT, 

Default location for TVHF files is the bin folder.  
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3. Open GMAT and load script ACE_impulsive_Burn_XXX.script. Within the Resources tree, this script will 

show under Scripts folder. Open this script and click “Save/Sync.” This populates GMAT’s Resources and 

Mission tree. 

 

4. Go to Mission tree and open “User Inputs” ScriptEvent. Under Input state section, notice use_tvhf is set to 

1 by default. This means GMAT will read spacecraft’s initial epoch, state & Cr from vec450.txt. All of the 

correct epochs and other parameters that correspond to vec450.txt vector file have already been entered into 

variables that are listed under Attitude Reorientation, Maneuver & Post maneuver epoch sections.  

 

Notice that model_reorr flag is turned on, attitude reorientation epoch has already been entered into 

reorr_epoch, radial, tangential, normal components have already been entered into reorr_radial, 

reorr_tangential, reorr_normal. Also appropriate fuel has also been entered into reorr_fuel_used.   

 

Correct maneuver epoch has been entered for maneuver_epoch, target_crossing is set to 4, correct tank 

mass is entered for tank_mass, appropriate fuel used has already been added for sk_fuel_used. Notice that 

define_spin_axis flag is turned on and appropriate RA and DEC values have already been added to Z_RA 

and Z_Dec.   

 

Under Post maneuver epoch section, postmaneuver_epoch is where user enters a user-defined epoch, which 

differs from the maneuver epoch. After targeter converges, spacecraft propagates to user-defined post 

maneuver epoch and ephemeris files are generated starting from the user-defined epoch defined in 

postmaneuver_epoch. This satisfies requirement listed under PO02 REQ-ID. Code 500 ephemeris (both PC 

and UNIX versions) and modified report file “GMATephem” are generated starting from the post 

maneuver epoch that the user defines in postmaneuver_epoch. A correct post maneuver epoch (which 

corresponds to vec450.txt vector file) has already been defined for tester’s convenience.  

 

NumDays_after_maneuver is where user defines the total # of days for which code 500 ephemeris and 

“GMATephem” report files will be generated for. By default, NumDays_after_maneuver is set to 180 days, 

which roughly equals to ACE’s full orbit revolution. This variable can be modified at user’s choice. 

 

5. Since “User Inputs” ScriptEvent is already configured with appropriate parameters, we are ready to run 

GMAT. Click OK to close “User Inputs” ScriptEvent & click on Run button (located below and slightly to 

the right of Help tab). 

 

As GMAT is running, user will see two graphics windows and two XY Plot windows. 

“EarthSunMoonView” graphics window shows spacecraft in RLP coordinate frame, “EarthSunView” 

graphics window shows ACE in earth-sun-rotating coordinate system & XY plot on bottom right shows 

ACE in XY RLP frame as the targeter runs and converges for up to 4 RLP XZ plane crossings. XY plot on 

bottom left shows spacecraft in XY RLP frame propagating forward starting from post maneuver epoch 
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which was defined in postmaneuver_epoch. Spacecraft in bottom left RLP XY plot propagates for # of days 

which was defined in NumDays_after_maneuver variable (in this case 180 days). These four graphics 

windows satisfy the XY RLP frame visualization & real-time updates requirements which are defined by 

PO05 and PO06 REQ-IDs.    

 

Note: While GMAT is running, GMAT’s Message Window shows all current targeter iterations and 

converged dV solutions for up to 4 XZ plane crossings. 

 

6. After GMAT run is completed, go to Output tree and open “GMATephem” report file. Similar to 

FreeFlyer, starting from the post maneuver epoch defined in postmaneuver_epoch, this report file reports 

UTC epoch, state vector, total mass and TAI Julian epoch at time steps of 3000 seconds. “GMATephem” 

report file is generated for # of days defined in NumDays_after_maneuver. “GMATephem” object was 

created in lines 463 through 475 of the script. “GMATephem” object can also be found in GMAT’s 

Resources tree under the Output folder.  

 

Now go to GMAT’s directory and open Output folder (by default, after each run, GMAT places all report 

and ephemeris files in its Output folder). In this Output folder, user will see two code 500 ephemeris files 

(in our case: ACE_vec450_PC.eph & ACE_vec450_Unix.eph). These code 500 ephemeris files are 

generated starting from user-defined epoch in postmaneuver_epoch and is generated for # of days defined 

in NumDays_after_maneuver. Similar to FreeFlyer, GMAT generates code 500 ephems at fixed time steps 

of 600 seconds. “CODE500PC” and “CODE500UNIX” objects (shown in the Resources tree) were created 

starting from lines 477 through 511 of the script). This satisfies the requirements defined under PO03 & 

PO04 REQ-IDs. 

 

Now go back to GMAT’s Output tree and open “skSummaryReport” report file. “skSummaryReport” is the 

maneuver summary report that GMAT generates as delineated in Appendix B. Now go to Output folder 

(located in GMAT’s directory). Inside the Output folder, you’ll find maneuver summary report titled 

“SK66_impulsive_GMAT_More.report”. “skSummaryReport” ReportFile object was created in lines 449 

through 461 of the script. “skSummaryReport” object can also be found in GMAT’s Resources tree under 

the Output folder. 

 

Study the contents of this maneuver summary report and tester can validate it against FreeFlyer’s maneuver 

summary report. GMAT’s maneuver summary report meets PO07 requirement as well as all of the 

requirements delineated in Appendix B (i.e. MR1 through MR06 requirements). 

 

7. The user can close GMAT now by going to File>Exit. 

 

EXPECTED RESULTS 

GMAT will demonstrate that it is able to generate code 500 ephemeris, can display real-time visualizations and 

generates a maneuver summary report.  
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ACCEPTANCE CRITERIA 

Validate expected results by running FreeFlyer with same input parameters used in “User Inputs” ScriptEvent. 

 

 

 

TEST PLAN REVIEWED AND APPROVED BY (PRINT NAME) 

 

 

See FDSS-LOP-0004 Flight Dynamics Facility (FDF) Local Operating Procedure (LOP) for Operations Test 

Methodology for instructions on completing this form. 

Acknowledgments 

 
The authors would like to acknowledge the assistance of entire GMAT team in particular Linda Jun, Darrel 

Conway, Wendy Shoan, Joel Parker, Steve Cooley and Thomas Grubb. R. Qureshi would like to thank FDF ACE 

maneuver planning team for their help throughout the operational certification process. He would also like to 

acknowledge Qumerunnisa Qureshi for her encouragement and support.  

 
References 

  
 1  Roberts, C.R., “Long Term Missions at the Sun-Earth Libration Point L1: ACE, SOHO, and WIND,” AAS/AIAA  

Astrodynamics Specialist Conference, Girdwood, Alaska, August 2011.  
 2 Roberts, C.R., "Long Duration Lissajous Orbit Control for the ACE Sun-Earth L1 Libration Point Mission." Advances  

in the Astronautical Sciences, Vol. 108, Part 2, 2001, pp. 1447–1464. 
 3Dunham, D.W., and Roberts, C.R., "Stationkeeping Techniques for Libration Point Satellites." The Journal of the  

Astronautical Sciences , Vol. 49, No. 1, January-March 2001, pp. 127–144. 
 4The GMAT Development Team, “General Mission Analysis Tool (GMAT) User Guide R2013b,” NASA GSFC. 
 5Hughes, S.P., “General Mission Analysis Tool (GMAT) Software Management Plan/Product Plan,” Version 1, October  

2013.  
 6Flight Dynamics Facility, Goddard Space Flight Center, “FDSS-TO9 Maneuver Task Requirements Traceability Matrix –  

ACE only.xlsx,” July 2013. 
 7GMAT, General Mission Analysis Tool, Software Package, Ver. R2013b, NASA Goddard Space Flight 

 Center, Greenbelt, MD, 2013. 
 8FreeFlyer based ACE Local Operating Procedures document, FDSS-LOP-0136 ACE LOPs_V2, Flight Dynamics Facility, 

NASA Goddard Space Flight Center, Greenbelt, MD, 2013. 
 9GMAT based ACE Local Operating Procedures document, GMAT-ACE-LOP_v4, Flight Dynamics Facility,  

NASA Goddard Space Flight Center, Greenbelt, MD, 2013. 
 10GMAT Test Plans and Procedures Form 15’s document, GMAT-ACE-Test-Plans-Form15s.zip, Flight  

Dynamics Facility, NASA Goddard Space Flight Center, Greenbelt, MD, 2013. 

 

 
 


